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Abstract:   

Neuroph is an open source software that provides Java-based software components and tools for 

developing neural networks. It is designed to be easy to learn, use, extend and customize for specific 

needs. Thanks to these features, Neuroph has gained wide adoption in the world-wide user community. 

This tutorial explains details about the Neuroph platform design and demonstrates its usage through 

examples, both in Java code and with tools with graphical user interface. The examples include an 

introductory (educational) classification demo with visualization, a basic classification demo with 

complete work-flow for neural network training and cross-validation, and a basic image recognition 

demo. It also demonstrates how it can be extended and used in specific application domains. The 

Neuroph platform is based on best software engineering practices, experience from other neural 

network software developed in Java, and on proven Java software industry standards like NetBeans 

Platform. 
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1. Introduction 

Neuroph
3
 is an open source software platform for neural network development, education and research. 

It provides a well-designed software development framework written in Java programming language 

[1], and an integrated development environment for neural networks, with graphical user interface 

(GUI) based on NetBeans Platform [2] 

Neuroph enables and makes easier the development of various types of neural networks, and their 

integration into the real world applications. It is primarily intended to be used by Java software 

developers and students. However, thanks to its flexibility and openness, it is also an interesting option 

for neural network research. 

Although there are many similar software frameworks and tools for neural networks developed in Java 

over the last decade [3] [4] [5] [6] [7] [8] [9] [10] [11], Neuroph managed to gain popularity and build 

community thanks to its ease of use and extensibility. Neuroph makes easy for software developers to 

learn about neural networks, create software components that use neural networks, and extend or 

customize existing types of neural networks (which are provided by the underlying software 

framework). 

Neuroph is being developed at the University of Belgrade with contributions from individual 

developers and universities all around the world [12].It has stable development history since its first 

release in 2008,with one release per year. At the moment, it has over 900 downloads per week, 
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according to the statistics from the official project download page
4
. 

It is being used for teaching neural networks at the University of Belgrade in the course on Intelligent 

Systems
5
, and it has won the Duke's Choice Award 2013

6
, which is the annual Java community award 

for the most innovative software on Java platform. 

Latest version of Neuroph software v2.92 is available for download in executable form, with full 

source code and documentation from official Neuroph site
7
  

This paper describes design, tools and main features of the Neuroph platform, through three application 

examples. It explains how use Neuroph to solve particular tasks, and provides information to 

understand Neuroph in order to be able to extend it or customize it. The paper is organized as follows: 

Section 2 provides an overview of Neuroph's internal design and tools. Section 3 provides a detailed 

description of three application cases, which demonstrate the usage and the most important features of 

the Neuroph software. These application cases include: an animated educational classification example, 

a simple Iris flower classification example, and an image recognition example. Section 4 gives an 

overview of the main extension points and guidelines for extending and customizing Neuroph. Some 

concluding remarks are given in section 5. 

2. Neuroph Design and Tools 

 

This section describes the general design, components and tools of the Neuroph platform. The main 

components of the Neuroph platform are: 

 

1. Neuroph framework, which provides a Java class library for various neural network 

components; and  

2. GUI tool called Neuroph Studio, which provides integrated development environment for 

neural networks based on the Neuroph framework and NetBeans Platform. 

 

2.1. Design of Neuroph Framework 
 

Neuroph is designed with the goal to provide easy to use, flexible and extensible environment for 

creating neural networks and making them part of a tool-set of Java software developers. So the main 

objectives of Neuroph design are to maximize the following factors of software quality: 

 

1. Usability – Neuroph should be easy to learn and use. In practice this means that there should be a 

small number of classes and methods required to learn, along with tools that make it easier to create, 

simulate, and analyze neural networks. 

 

2. Flexibility and extensibility – it should be easy to extend Neuroph (add new features) and customize 

it (modify existing features) for specific needs. 

 

3. Re-usability – it should be easy to deploy Neuroph in various environments and application domains, 

with high level of code reuse when developing extensions based on existing Neuroph components. 

 

                                                 
4 http://sourceforge.net/projects/neuroph/files/ 
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In order to meet these goals, domain-driven and hot-spot-driven design principles were applied. 

Domain driven approach [13]means to base a complex design on a domain model, which results in 

better understandability and learn-ability. In the case of the neural network framework design, this 

means choosing framework elements so that they correspond to neural network domain concepts, 

which makes the design easier to understand. 

Following these principles, the main concepts in the neural network domain used for Neuroph design 

are: 

 

• Neural Network – a network that consists of a layers of interconnected processing units 

(neurons) that can learn from some data set  using a corresponding learning algorithm.  

• Learning algorithm – an algorithm that adjusts the network parameters (connection weights) 

during the training procedure until the network gets a desired behavior 

• Data Set  – a collection of data that is used in the training procedure and for testing the network 

• Layer – a collection of neurons 

• Neuron – a basic processing unit in the network; can use various input and transfer functions 

• Connection – connection between two neurons with associated Weight 

 

Hot-spot-driven design [14] [15]is about aspects that have to be kept flexible using appropriate 

abstractions, so these can be easily changed. The problem with framework design is how to balance the 

flexibility versus the complexity of use of that framework [4]. The complexity of keeping the 

framework exceedingly flexible also makes the framework harder to reuse and maintain. Less flexible 

solutions tend to keep the framework smaller and easier to maintain and reuse. Thus to find out the 

most important hot spots becomes a major issue when designing a framework [16].  

The most general requirement for flexibility of a neural network framework is to support different 

types of neural network architectures and learning algorithms, and make them domain/application 

independent. In order to achieve that, the design needs to support different types of neurons, input and 

transfer functions, connectivity patterns and interaction between neurons, and different types of 

learning algorithms. All of these represent 'hot spots' of the framework. 

The goal of Neuroph's design regarding flexibility was to come with generic base design that can be 

extended to create any possible type of neural network, or at least to create the design that is possible to 

evolve into that direction over time.  

Regarding re-usability, the design objectives are to enable creating new types of neural networks, 

learning algorithms, and other neural network components, with minimal coding effort, and to allow 

reuse of existing components. Also, the design should support reuse of neural network components in 

different applications, as well as use of different types of neural networks in the same application with 

minimal change. In addition, it should support commonly adopted procedures for neural network 

training and development regardless of the application domain. 

Following these ideas and guidelines, the core design of the Neuroph framework has evolved as shown 

on the class diagram in Figure 1. 

  



 

Fig. 1 The core 

 

In general, the Neuroph framework provides a set of base classes (

by using inheritance and overriding specific methods. This approach provides the same general 

structure for different types of neural networks. The main classes, methods

briefly explained in the rest of this section, while more technical details 

 

 

 

 

The core class diagram of the Neuroph framework 

In general, the Neuroph framework provides a set of base classes (Fig. 1), which can be easily extended 

by using inheritance and overriding specific methods. This approach provides the same general 

structure for different types of neural networks. The main classes, methods, and extension points are 

of this section, while more technical details are available in section 4.

4 

which can be easily extended 

by using inheritance and overriding specific methods. This approach provides the same general 

and extension points are 

available in section 4. 
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1) The NeuralNetwork class is the base class for all types of neural networks. It contains a collection 

of neuron layers and a learning rule. It provides methods that represent a common public interface for 

all types of neural networks, which are: 

setInput()  - sets the network input 

calculate() - calculates the network output. The default implementation is sequential calculation of the 

network layers. For different calculation strategies, this method should be overridden and it can 

delegate calculation to other classes. 

getOutput() - returns the network output 

learn(DataSet  data set ) - runs a learning algorithm with the specified data set . This method delegates 

the learning algorithm to some implementation of the LearningRule class. 

Specific types of neural networks are defined by extending this class, implementing the method that 

creates a specific network architecture (layers, neurons and connections), and setting the appropriate 

learning algorithm based on the LearningRule class.  

2) The LearningRule class is an abstract base class for all types of learning algorithms. The extension 

point is the abstract method learn(),which should be implemented by subclasses in order to create 

specific learning algorithms. It also provides methods to control learning (stop, pause, resume), a 

learning event mechanism, and methods that can be overridden in some learning stages (onStart, 

onStop). 

This class is inherited by UnsupervisedLearning and SupervisedLearning, which are further inherited 

by specific learning rules like LMS, Backpropagation, etc. 

3) The DataSet  class represents a collection of data that the network should learn during the training 

process. It can contain both supervised and unsupervised training data. 

4) The Layer class is a collection of neurons, and also a base class for different types of layers. In most 

of cases, the basic layer class is enough. It provides methods to add to and remove neurons from a 

layer, and the calculate() method that calculates the output of all neurons in a layer. The default 

implementation does sequential calculation of neurons outputs, and different strategies for calculation 

can be implemented by sub classing and overriding the calculate() method. 

5) The Neuron class is a base class for all types of neurons. It has an input function and a transfer 

function, collections of input and output connections to other neurons and the calculate() method that 

delegates calculation of the neuron output to its input and transfer functions. Different calculation 

behavior can be implemented by overriding the calculate() method.  

6) The InputFunction class is an abstract class used as a base class for all types of a neuron's input 

functions. It has one abstract method - getOutput(Connection[] inputConnections) - which has an array 

of input connections as an input parameter, and returns the result/output of the input function.Specific 

input functions are implemented by extending this class and implementing the method getOutput(). The 

framework provides implementations of many commonly used input functions: weighted sum, 

distance, and, or, min, max, etc. 

7) The TransferFunction class is an abstract class used as a base class for all types of a neuron's 

transfer functions. It has two important methods: the abstract method getOutput(double net),which 

should return the output of a specific transfer function, and getDerivative(double net), which should 

return the first derivative of a specific function. The framework provides implementations of many 

commonly used transfer functions, like: step, sigmoid, tanh, gaussian, linear, ramp, log, sin, etc. 

8) The Connection class represents a weighted connection between two neurons. It holds references to 
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from and to neurons, and the connection weight, which is an instance of the Weight class, so the single 

Weight instance can be shared by multiple connections (which is an important feature of architectures 

like Convolutional networks). 

9) The Weight class stores a value of the connection weight (as a real number) and the weight change 

(which is calculated by the learning rule).It also may contain additional data used by the learning rule 

and related to that weight (so called trainingData). This class does not have subclasses, and typical 

scenarios do not require this class to be extended. 

10) The PluginBase class is a base class of the Neuroph plugin system, with the purpose to provide an 

extensible mechanism to create application-specific functionalities and keep them separated from the 

neural-network-related classes. In practice, this is done by creating an application-specific plugin class 

that inherits PluginBase and adds application-specific methods (like, for example, 

ImageRecognitionPlugin). This class is used to separate application-specific logic from neural-

network-related logic, which is identified as one of the main problems with neural network 

development and reuse. 

As of version 2.9, Neuroph supports the following types of neural network architectures: Adaline, 

Perceptron, Multi Layer Perceptron [17], Hopfield [18], Bidirectional Associative Memory [19], 

Kohonen [20], Instar [21], Outstar [21], Competitive Network [22], MaxNet [22], Radial Basis 

Function Network [23], Neuro Fuzzy Perceptron [24], Hebbian Network [25], and Convolutional 

Network [26]. From this list of supported neural networks, it can be seen that the basic Neuroph design 

supports creation of the following types of neural network architectures: feed forward, recurrent, fully 

connected, competitive. Thanks to flexibility and reusability of the base components, it also supports 

creation of modified custom components and connectivity patterns between neurons. 

Neuroph supports the basic supervised and unsupervised learning rules and their variations, which are 

used by the networks listed above. The supported learning rules include: LMS, Perceptron Learning, 

Delta Rule, Backpropagation [17] , Resilient Propagation [27], Dynamic Backpropagation, Hebbian 

Learning [25], Anti Hebbian Learning [28], Oja Learning [29], Instar Learning [21], and Outstar 

Learning [21].  

From the list of supported types of learning rules, it can be seen that the base Neuroph design supports 

creation of the following types of learning rules; Unsupervised (Hebbian, Kohonen, Competitive), 

Supervised (LMS, Backpropagation, etc.) and single-pass like Hopfield Learning [18] . 

 

The working implementation of a wide variety of neural network architectures and learning rules 

supported by Neuroph are all based on the same base components, which demonstrates the flexibility 

and reusability of the design. 

 

 



 

2.2. Neuroph Studio 

Neuroph Studio is an integrated development 

interface (GUI); it is built on top of the NetBeans Platform. 

neural networks with the Neuroph framework.

shown in Figure 2. 

 

 

Fig. 2 The main window of Neuroph Studio development environment 

 

Neuroph Studio provides a wizard-based workflow for neural network development, which is familiar 

to software developers, and guides 

specific task. It also provides visual tools to create and analyze neural network

Neuroph Studio provides the following main components:

1. Project System – manages a set of neural network and 

2. Wizard System – provides a set of wizards for creating neural networks and

3. Visual Editor & Palette – visual tool 

using drag 'n' drop from component palette

4. Explorer View- provides a tree

5. Properties View – provides all settings 

6. Visualization System – provides various 2D and 3D visualization

and data set s 

development environment for neural networks, with 

built on top of the NetBeans Platform. It provides tools for creating and analyzing 

Neuroph framework. The main window of the Neuroph Studio 

window of Neuroph Studio development environment 

based workflow for neural network development, which is familiar 

to software developers, and guides the user through a series of steps/dialogs in order to accomplish 

specific task. It also provides visual tools to create and analyze neural networks and 

Neuroph Studio provides the following main components: 

manages a set of neural network and data set  files for some specific problem

provides a set of wizards for creating neural networks and 

visual tool for editing neural network components and connections 

n' drop from component palette 

provides a tree-like view of neural network components 

provides all settings of the currently selected neural network component

provides various 2D and 3D visualizations of different 
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with a graphical user 

It provides tools for creating and analyzing 

Neuroph Studio application is 

window of Neuroph Studio development environment  

based workflow for neural network development, which is familiar 

user through a series of steps/dialogs in order to accomplish a 

s and data sets. 

files for some specific problem 

 data sets 

neural network components and connections 

currently selected neural network component 

different neural networks 
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7. Training System - a set of dialogs for setting all training parameters and monitoring training 

8. Cross-validation tool – a tool for automated cross-validation 

9. Application-specific tools – various tools for application-specific domains like image 

recognition, optical character recognition, EEG signal recognition etc. 

 

A detailed description of these Neuroph Studio components is given in application examples presented 

in section 3. 

 

NetBeans Platform, which is used as a base for Neuroph Studio, is a generic framework for building 

rich, complex Java desktop applications. It provides flexible modular architecture, rich set of graphical 

user interface components, and many other important features that can be easily reused. NetBeans 

Platform is an open-source software, developed by Oracle Corporation. Neuroph Studio adds neural-

network-specific tools based on the Neuroph framework to NetBeans Platform in the form of additional 

NetBeans modules/plug-ins. 

This also makes easy for Neuroph to integrate with other software based on NetBeans Platform, for 

example NetBeans Java IDE. This way, Neuroph Studio provides an integrated neural network and 

Java development environment, and make it easier for software developers to create, use, and integrate 

neural networks in their software projects.   

 

Hardware and software requirements 

 

Neuroph Studio runs on operating systems that support Java Virtual Machine (Windows, Linux, Mac), 

and meet the following recommended requirements: 

 

CPU: 2.6 GHz Intel Pentium IV or equivalent,  

Memory: 2Gb 

Java version: 1.8 

 

Note that default settings for assigned memory for Java Virtual Machine in Neuroph Studio  are pretty 

low (only 64Mb), but if Neuroph Studio becomes unstable, or 'Out of memory error' occurs,  more 

memory should be assigned to it using -J-Xmx switch in configuration file 

[NeurophStudioHomeDir]/etc/neurophstudio.conf
8
 

 

3. Application Cases 

 

This section shows how Neuroph software is used to solve some typical machine learning problems, 

like classification and image recognition. Three application cases show how to use visual tools from 

Neuroph Studio to create and train neural networks, and then the same problems are solved in Java 

code. The first demo is educational and its focus is on the training procedure. The classification 

problem data set  and the neural network are generated automatically, with the smallest number of 

settings, and the user can easily train the network using the training dialog. This demo also provides 

visualization tools which enables better understanding of neural network training and operation. 

The second demo is more realistic and shows how to import a data set  from an external file, and create 

and customize neural network using a specialized wizard. This is demonstrated using the Iris 

classification problem. 

                                                 
8 https://sourceforge.net/p/neuroph/discussion/862858/thread/17bf78d7/ 



9 

 

The third demo shows how to use Neuroph in a specific application domain, which is in this case image 

recognition. 

3.1. Basic Classification Demo 

This demo shows how to solve simple classification problems using the Neuroph Studio GUI. Neuroph 

Studio provides wizard-based tools to generate sample data set s and neural networks, for simple 

classification problems, and then train and test the neural networks. NeurophStudio also provides 

visualization tools that help the user to get a better understanding of the problem, the network 

architecture, the learning algorithms and the network operation. 

This demo is an educational example, useful for teaching neural networks, explaining basic concepts, 

workflow, visualization of the problem (data set ) and Multi Layer Perceptron operation (learning and 

classification). 

The problem is defined as follows: Create and train Multi Layer Perceptron neural network to classify a 

set of two-dimensional points (vectors). The set of two-dimensional points is generated automatically, 

as a sample data set , where each point belongs to one of the two possible classes (red or blue). The 

class of a point is determined during the data set  generation, using simple shape patterns: if the point 

belongs to the inner part of the shape then it is blue, otherwise it is red. There are several different 

shapes that can be used: ellipse, circle, square, diamond, moon, ring, etc. 

 

Brief overview of the procedure 

 

The problem described above can be solved with Neuroph Studio in the following steps: 

1. Creating a Multi Layer Perceptron Classification Sample Project 

2. Generating a sample data set  for classification, based on a predefined shape. 

3. Creating a Multi Layer Perceptron neural network, with a selected predefined architecture. 

4. Training the neural network. Apply the training procedure to the neural network using the generated 

data set . 

 

These steps can be easily executed and visualized using Multi Layer Perceptron Classification Sample 

in Neuroph Studio. The text that follows explains the main points with screenshots and step-by-step 

instructions for running this sample. 

 

Step 1. Creating a Multi Layer Perceptron Classification Sample Project 

 

Neuroph Studio has a project-based workflow, which means that the first thing that needs to be done 

when working on some problem is to create a project. A project is a logical set of neural networks, data 

set s, and specific tools available in specific types of projects. Different types of projects are created by 

using the 'New Project' wizard and selecting the project type. 

The Multi Layer Perceptron Classification Sample project wizard (Fig. 3) is launched from the main 

menu: 

Main Menu > File > New Project > Samples > Neuroph > Multi Layer Perceptron Classification 

Sample  

 

After the 'next' button is clicked, the wizard asks for the name and location of the project, and the 

project will be created in a folder at a specified disk location. There are three main components that 

will be available upon the project creation (Fig. 4): 

 

 



 

Fig. 3Multi Layer Perceptron Classification Sample Project Wizard

 

1) Project Window - contains neural networks and 

2) Visualization Window –provides 2D visualization 

network learning 

3) Sample Controls Window –provides controls for creating 

visualization options. 

 

 

Fig. 4 The main view of Multi Layer Perceptron Classification Sample 

 
Multi Layer Perceptron Classification Sample Project Wizard

contains neural networks and data set s organized into folders 

provides 2D visualization of the problem data set and animated neural 

provides controls for creating data set , neural network and setting 

view of Multi Layer Perceptron Classification Sample 
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Multi Layer Perceptron Classification Sample Project Wizard 

 

set and animated neural 

, neural network and setting 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

view of Multi Layer Perceptron Classification Sample  



 

Step 2. Creating a data set 

 

To create a data set, select one of the Shape options (for example Diamond) in Sample Controls 

Window and click the 'Create Data S

be created (Fig. 5). 

 

A data set  for the selected shape will be created under 

and visualized in the visualization window (

 

Fig. 6 Visualization of c

 

 

 

set, select one of the Shape options (for example Diamond) in Sample Controls 

Set' button. It is also possible to set the number of points that will 

 

Fig. 5 Create data set  controls 

 

selected shape will be created under the Training Sets folder in the 

visualization window (Fig. 6). 

Visualization of created diamond data set  
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set, select one of the Shape options (for example Diamond) in Sample Controls 

It is also possible to set the number of points that will 

 

 

 

 

 

 

 

 

 

 

 

the Project Window, 



 

Each 2D point in the generated data 

that can be either 1 (blue, or inner shape point) or 0 (red or outer shape point). 

can also be viewed as a table with numerical values

(Fig. 7). 

 

 

 

Step 3.  Creating a Multi Layer Perceptron neural network

 

To create a Multi Layer Perceptron, select 

Controls Window and click the 'Create Neural Network' button (

 

Fig. 8 Controls for creating 

 

The network structure corresponds to 

example, 2:9:1 means that the neural network has two neurons in 

hidden layer, and one neuron in the 

neurons in the input layer, and one neuron in 

single binary [0, 1] classification as 

 

A Multi Layer Perceptron neural network will be create

Project Window, and it can be opened 

Visual Editor provides a visual, component

neurons and connections. It enables inspection and modification of the individual components.

 

 set has two values in the interval [-1, 1] and the 

or inner shape point) or 0 (red or outer shape point). The g

can also be viewed as a table with numerical values, by clicking the data set  in the project window 

Fig. 7 Data set  table view 

Perceptron neural network 

To create a Multi Layer Perceptron, select the network structure and transfer function in the Sample 

'Create Neural Network' button (Fig. 8). 

Controls for creating a neural network 

etwork structure corresponds to the number of neurons and layers in a neural network. For 

neural network has two neurons in the input layer, nine neurons in 

the output layer. In this example, all proposed architectures have two 

, and one neuron in the output layer, since the input is two

single binary [0, 1] classification as the output. 

A Multi Layer Perceptron neural network will be created under the 'Neural Networks' folder in 

Project Window, and it can be opened using the Visual Editor tool in the central window (

component-based view of a neural network architecture: layers, 

tions. It enables inspection and modification of the individual components.
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the classification class 

The generated data set  

project window 

network structure and transfer function in the Sample 

 

 

 

 

 

 

 

 

 

neural network. For 

input layer, nine neurons in the 

ll proposed architectures have two 

two-dimensional and a 

'Neural Networks' folder in the 

central window (Fig. 9). 

based view of a neural network architecture: layers, 

tions. It enables inspection and modification of the individual components. 



 

Fig. 9

 

Note that individual additional neurons in 

neurons that are added by default. Bias neurons represent constant input for all neurons in next layer, 

that helps faster convergence of  Backpropagation learning rule.

 

Step 4. Training a neural network 

To start the neural network training with some 

network has to be dragged 'n' dropped

the center, to enable the train button in the toolbar. By drop

window, the user indicates that he wants that neural network to learn the 

 

 

Fig. 10 Drag 

 

Fig. 9 Visual neural network editor 

additional neurons in the input and hidden layers shown in Fig. 9 represent bias 

Bias neurons represent constant input for all neurons in next layer, 

that helps faster convergence of  Backpropagation learning rule. 

To start the neural network training with some data set  and observe the training proc

dropped from the Project Window to the data set  visualization window in 

the center, to enable the train button in the toolbar. By dropping the neural network in the visualization 

t he wants that neural network to learn the visualized

Drag 'n' drop the neural network and start training 
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. 9 represent bias 

Bias neurons represent constant input for all neurons in next layer, 

and observe the training process, the neural 

visualization window in 

neural network in the visualization 

visualized data set .  



 

Clicking the 'Train' button in the toolbar (

 

Fig. 11

The training dialog provides various settings for the learning algorithm like Max Error, Learning Rate 

and Momentum. For the purpose of this demo, 

'Train' button starts the training procedure: 

displays the network operation in the 

Note that the dialog also provides some advanced settings for 

described in more detail in Section 3.2.

 

 

toolbar (Fig. 10) opens the training dialog (Fig. 11).

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

11 Training dialog with default settings 

 

The training dialog provides various settings for the learning algorithm like Max Error, Learning Rate 

and Momentum. For the purpose of this demo, the provided default values are accepted

'Train' button starts the training procedure: it opens real-time total network error graph (

the visualization window. 

dialog also provides some advanced settings for the cross-validation proc

3.2. 
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. 11). 

The training dialog provides various settings for the learning algorithm like Max Error, Learning Rate 

provided default values are accepted. Clicking the 

time total network error graph (Fig. 12) and 

validation procedure, which is 



 

Fig. 12 Total network error graph during training

Total network error graph shows the value of total network error during the training iterations. During 

the training, this is displayed on real

for the entire training. The fundamental principle of all supervised learning algorithms is minimization 

of a total error, and this graph helps to get 

The network operation during the training

This way, it is possible to observe how classification boundaries are changing during 

final training result shown in Fig. 13 shows how decision boundaries have formed 

which was the one used for training 

the provided data set . 

Fig. 13 Visualization of 

 

Total network error graph during training 

 

Total network error graph shows the value of total network error during the training iterations. During 

real-time scrolling graph, and at the end of the training it

for the entire training. The fundamental principle of all supervised learning algorithms is minimization 

of a total error, and this graph helps to get a better understanding of that process. 

training can be observed in real time in the visualization window. 

it is possible to observe how classification boundaries are changing during 

. 13 shows how decision boundaries have formed a 

 in this example. This picture shows how the trained network 'sees' 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Visualization of the data set  and classification by the trained network
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Total network error graph shows the value of total network error during the training iterations. During 

training it is displayed 

for the entire training. The fundamental principle of all supervised learning algorithms is minimization 

can be observed in real time in the visualization window. 

it is possible to observe how classification boundaries are changing during the training. The 

a diamond shape, 

. This picture shows how the trained network 'sees' 

trained network 



 

Figure 14 shows how the hidden neurons are creating decision areas, and 

decision lines of the hidden neurons are dividing 

 

Fig. 14 Visualization of 

 

By using these visual tools, the user can easily experiment with different neural network architectures 

and learning rule settings, in order to see how they affect training and classification boundaries.

Figure 14 shows how the hidden neurons are creating decision areas, and Figure 15 shows how 

decision lines of the hidden neurons are dividing the input space. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Visualization of areas created by neural network classifier

user can easily experiment with different neural network architectures 

in order to see how they affect training and classification boundaries.
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15 shows how 

areas created by neural network classifier 

user can easily experiment with different neural network architectures 

in order to see how they affect training and classification boundaries. 



 

Fig. 15 Visualization of the 

 

This classification demo shows the 

networks in Neuroph Studio. It also shows how visual tools can help in getting 

of the basic neural network components and operation. This tool is used for teaching neural networks 

the course on Intelligent Systems at 

concepts, and using visual representation helps students to understand 

neural network classifiers. 

 

3.2. Iris Classification Example

 

This example shows how to use Neuroph to solve 

data set, using Neuroph Studio GUI, and 

set , create and train the corresponding 

This example uses the Iris flowers data set 

 

Problem description: Iris flower classification problem 

Fisher’s Iris data set  (Fisher, 1936) is 

data set  contains 3 classes with 50 instances each, where each class refers to a type of 

One class is linearly separable from the other two; the latter are not linearly separable from each other.

This data set  has become a typical test case for many classification techniqu

The data set  contains the following attributes: 

1). sepal length in cm  

2). sepal width in cm  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

the decision lines created by the neurons in the hidden layer

the basic components and workflow when working with neural 

Studio. It also shows how visual tools can help in getting a better understanding 

basic neural network components and operation. This tool is used for teaching neural networks 

course on Intelligent Systems at the University of Belgrade. It clearly demonstrates high

and using visual representation helps students to understand the main principles behind 

3.2. Iris Classification Example 

This example shows how to use Neuroph to solve a classification problem, starting 

GUI, and also in Java code. The example shows how to import 

the corresponding neural network, and apply a performance evaluation procedure.

data set  for demonstration purposes. 

Iris flower classification problem  

(Fisher, 1936) is a well-known data set  in the pattern recognition literature. The 

0 instances each, where each class refers to a type of 

One class is linearly separable from the other two; the latter are not linearly separable from each other.

me a typical test case for many classification techniques in machine learning. 

following attributes:  
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hidden layer 

basic components and workflow when working with neural 

better understanding 

basic neural network components and operation. This tool is used for teaching neural networks in 

early demonstrates high-level 

main principles behind 

starting from an external 

Java code. The example shows how to import a data 

performance evaluation procedure. 

in the pattern recognition literature. The 

0 instances each, where each class refers to a type of the iris plant. 

One class is linearly separable from the other two; the latter are not linearly separable from each other. 

es in machine learning.  



 

3). petal length in cm  

4). petal width in cm  

5). class:  

- Iris Setosa  

- Iris Versicolour  

- Iris Virginica 

 

In order to solve this problem using Neuroph, a Multi Layer Perceptron neural network, which is 

commonly used as a classifier, needs to be trained with 

 

This problem can be solved using the 

 

 1. Create a new empty Neuroph project

 

2. Import data set . Create a data

 

3. Create a Multi Layer Perceptron neural network. 

 

4. Train the neural network. Apply the training and testing 

procedure using imported data set 

 

3.2.1. Iris Classification Example Using 

Step 1. Create a new empty Neuroph project: 

When working with neural networks and 

structure and context. A wizard for creating 

the main menu: Main Menu > File > New Project > Neuroph > Neuroph Project

Fig. 16

 

In the next step, the wizard asks for the name and location of the project, and then creates the project in 

In order to solve this problem using Neuroph, a Multi Layer Perceptron neural network, which is 

commonly used as a classifier, needs to be trained with the provided Iris flowers data set 

the Neuroph Studio GUI, through the following steps:

1. Create a new empty Neuroph project 

data set object from the given file in CSV format;

3. Create a Multi Layer Perceptron neural network.  

4. Train the neural network. Apply the training and testing procedure including cross

data set . 

3.2.1. Iris Classification Example Using the Neuroph Studio GUI 

Step 1. Create a new empty Neuroph project:  

hen working with neural networks and data set s, a Neuroph project system provides a folder 

A wizard for creating a new, empty Neuroph project (Fig. 16), is launched from 

Main Menu > File > New Project > Neuroph > Neuroph Project. 

Fig. 16 New Neuroph Project Wizard 

wizard asks for the name and location of the project, and then creates the project in 
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In order to solve this problem using Neuroph, a Multi Layer Perceptron neural network, which is 

data set . 

following steps: 

object from the given file in CSV format; 

procedure including cross-validation 

system provides a folder 

. 16), is launched from 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

wizard asks for the name and location of the project, and then creates the project in 



 

a folder with the project name, at a specified disk location (

user can import data set s to create training sets, create neural networks using 

neural network. 

 

Fig. 17

Step 2. Create classification data set 

The original Iris Classification data set 

(https://archive.ics.uci.edu/ml/data set 

corresponds to the instance class (as described in 

and use this data set  in Neuroph Studio, the original 

features are normalized to the range [0, 1] 

attribute is converted into three binary numeric 

preprocessing is required, since neural networks operate with values 

the original and normalized values for a single 

 

 

Original values  5.1 3.5

Normalized values 0.6455 0.7954

Tab. I Original and 

 

Note that data set s can also be normalized in Neuroph Studio, but in order to keep the focus of 

tutorial, the prepared data set  is provided in supplementary material

normalized.txt.  

The preprocessed file can be imported in 

launched from the main menu: Main menu > F

                                                 
9 http://ai.fon.bg.ac.rs/wp-content/uploads/2015/12/SupplementaryMaterial.zip

project name, at a specified disk location (Fig. 17). In the empty Neuroph project, 

s to create training sets, create neural networks using the wizard

 

 

 

 

 

 

Fig. 17 Neuroph project structure 

data set  by importing it from a CSV file 

data set  available from the UCI Machine Learning repository 

data set s/Iris) has four numerical and one nominal attribute

instance class (as described in the problem description section). In order to import

in Neuroph Studio, the original data set  must be preprocessed, so the numerical 

range [0, 1] by using the max normalization, and 

attribute is converted into three binary numeric attributes (since there are three nominal classes). This 

since neural networks operate with values in the range [0,1]. Table I shows 

the original and normalized values for a single data set  row. 

Inputs Output(s)

3.5 1.4 0.2 Iris-

0.7954 0.2028 0.08 1 0 

 

Original and preprocessed data set  values 

can also be normalized in Neuroph Studio, but in order to keep the focus of 

is provided in supplementary material
9
 in file Iris-data set 

reprocessed file can be imported in the Neuroph project using the New Data set 

Main menu > File > New > Neuroph >Data set (Fig

content/uploads/2015/12/SupplementaryMaterial.zip 
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empty Neuroph project, the 

wizard, and train the 

 

 

available from the UCI Machine Learning repository 

has four numerical and one nominal attribute, which 

problem description section). In order to import 

must be preprocessed, so the numerical 

max normalization, and the nominal class 

attributes (since there are three nominal classes). This 

range [0,1]. Table I shows 

Output(s) 

-setosa 

0 

can also be normalized in Neuroph Studio, but in order to keep the focus of the 

data set -

Data set  wizard, which is 

ig. 18). 



 

Fig. 

In the next step (Fig. 19), the wizard asks for 

Neuroph Studio from the given CSV file.

Fig. 19

 

Fig. 18 The New Data set wizard 

wizard asks for the information required for creating the 

Neuroph Studio from the given CSV file. 

 

Fig. 19 The New Data set wizard parameters 

20 

the data set  in 



 

The parameters that need to be specified when importing 

Data set  name Name of a data set 

Data set  type Data set  type;

value is Supervised

set . 

Number of inputs Number of input values in each 

4, since there are 4 attributes 

Number of outputs Number of output values in each 

supervised data set 

values. For Iris classification

binarized to 3 outputs in 

File The actual data set 

Delimiter Value delimiter in 

semicolon) 

Tab II

Figure 19 shows the settings for importing 

file provided in the supplementary material.

The imported data set  is shown in the 

order to see the imported values, or visualized in 2D or 3D using some of the Neuroph Studio 

visualization tools. 

Data set  visualization is important for users in order to get 

Figure 21 shows the Iris classification 

classes can be observed with respect to 

Neuroph Studio supports the following types of

clicking the data set in the project view

• 2D Scatter, 2D Line 

• 3D Scatter, 3D Surface, 3D Histogram

that need to be specified when importing the data set  are described in the T

data set  

; can be supervised or unsupervised. For Iris classification

Supervised, since there is a target class specified for each row in the 

Number of input values in each data set  row. For Iris classification

since there are 4 attributes in the data set . 

Number of output values in each data set  row. Outputs are specified only for 

data set s, and they correspond to neural network outputs and target 

values. For Iris classification, this value is 3, since the nominal class attribute is 

o 3 outputs in the preprocessed data set. 

data set  file on disk (in CSV format).  

Value delimiter in the CSV file (possible values are coma, space, tab or 

 

Tab II The Data set  wizard parameters 

Figure 19 shows the settings for importing the Iris Classification data set  from the preprocessed CSV 

file provided in the supplementary material. 

the project window, and it can be opened in tabular form (

imported values, or visualized in 2D or 3D using some of the Neuroph Studio 

 

Fig. 20 The imported data set 

visualization is important for users in order to get a better understanding of the problem. 

Figure 21 shows the Iris classification data set visualized with 2D scatter graph, where classification 

respect to the chosen input attributes. 

Neuroph Studio supports the following types of data set  visualization(which can be 

project view): 

3D Scatter, 3D Surface, 3D Histogram 
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are described in the Table II. 

can be supervised or unsupervised. For Iris classification, this 

, since there is a target class specified for each row in the data 

row. For Iris classification, this value is 

row. Outputs are specified only for 

s, and they correspond to neural network outputs and target 

minal class attribute is 

CSV file (possible values are coma, space, tab or 

preprocessed CSV 

project window, and it can be opened in tabular form (Fig 20) in 

imported values, or visualized in 2D or 3D using some of the Neuroph Studio 

better understanding of the problem. 

visualized with 2D scatter graph, where classification 

can be launched by right-



 

Fig. 21 Scatter 2D visualization of 

 

Step 3. Creating a new Multi Layer Perceptron neural network using 

A new Multi Layer Perceptron neural network that will be trained with 

can be created with the 'New Neural Network'

Main Menu > File > New > Neuroph > Neural Network

 

Figures 23-24 show screen-shots of the New Neural Network wizard steps for creating 

Perceptron network type. 

In the first step (Fig. 23), the wizard expects a name an

example, the neural network type is Multi Layer Perceptron. 

In second step (Fig. 24), the wizard expects 

network type to be entered. 

 

 

 

 

 

Scatter 2D visualization of the Iris Classification data set 

Step 3. Creating a new Multi Layer Perceptron neural network using a wizard

A new Multi Layer Perceptron neural network that will be trained with the Iris classification 

'New Neural Network' wizard, which is launched from the main menu (

File > New > Neuroph > Neural Network 

shots of the New Neural Network wizard steps for creating 

wizard expects a name and neural network type to be provided.

example, the neural network type is Multi Layer Perceptron.  

wizard expects the parameters specific to Multi Later Perceptron neural 

22 

data set  

wizard 

Iris classification data set 

main menu (Fig 22): 

shots of the New Neural Network wizard steps for creating the Multi Layer 

d neural network type to be provided. In this 

parameters specific to Multi Later Perceptron neural 



 

Fig. 22 Starting 

Fig. 23The 

 

Starting the New Neural Network Wizard 

 

The New Neural Network Wizard step 1 
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Fig. 24 

Parameter Description

Input neurons Number of network inputs

set 

Hidden neurons Number of hidden neurons, which actually learn the structure of the 

inputs. 

Output neurons Number of neurons in 

number of outputs in 

is 3)

Use Bias Neuron This option determines whether all neurons should use a single 

constant input or 

option is usually used

Connect input to output neurons This option determines whether 

directly connected to 

Transfer function T

layer

Learning rule The

used by 

Backpropagation, Backpropagation with Momentum, Resilient 

Propagation. 

used in this example for Iris classification problem, since 

additional momentum parameter improves learning significantly.

Tab III Multi Layer

 The New Neural Network Wizard step 2 

Description 

Number of network inputs; this corresponds to the 

set  inputs (for the Iris classification, this value is 4)

Number of hidden neurons, which actually learn the structure of the 

inputs.  

Number of neurons in the output layer, which corresponds to the 

number of outputs in the data set  (for Iris classification

is 3) 

This option determines whether all neurons should use a single 

constant input or the so called bias, which improves learning. This 

option is usually used, so it is checked by default.

This option determines whether the input neurons should be 

directly connected to the output neurons 

The transfer function that will be used by the hidden and output 

layers. Commonly used ones are Sigmoid and Tanh.

The specific type of the Backpropagation algorithm 

used by the network. Neuroph supports several types: 

Backpropagation, Backpropagation with Momentum, Resilient 

Propagation. The Backpropagation with Momentum algorithm is 

used in this example for Iris classification problem, since 

additional momentum parameter improves learning significantly.

 

Multi Layer Perceptron wizard parameters 
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the number of data 

this value is 4) 

Number of hidden neurons, which actually learn the structure of the 

output layer, which corresponds to the 

(for Iris classification, this value 

This option determines whether all neurons should use a single 

which improves learning. This 

s checked by default. 

input neurons should be 

hidden and output 

are Sigmoid and Tanh. 

Backpropagation algorithm that will be 

network. Neuroph supports several types: 

Backpropagation, Backpropagation with Momentum, Resilient 

Backpropagation with Momentum algorithm is 

used in this example for Iris classification problem, since the 

additional momentum parameter improves learning significantly. 



 

The Multi Layer Perceptron network created by the wizard is automatically opened in the visual editor 

window, with the component palette available on the right, for additional inspection and editing (

25). The additional neuron in the input and hidden 

Fig. 25 Multi Layer Perceptron created with 

The properties of each neural network component can be inspected in 

windows , and new layers, neurons and connections can be added or changed using 

and the component palette.  

 

Step 4. Basic neural network training

To train the created Multi Layer Perceptron with 

procedure is the same as in the previous example:

1. Drag 'n' drop the data set to the specified area in 

button in the toolbar (Fig. 26) 

2. Set the training parameters in the 

Fig. 26 Starting the neural network training for 

3. During the training, Neuroph Studio displays 

example (Fig. 12). 

The Multi Layer Perceptron network created by the wizard is automatically opened in the visual editor 

component palette available on the right, for additional inspection and editing (

input and hidden layers is the bias neuron with constant output.

Multi Layer Perceptron created with the New Neural Network 

of each neural network component can be inspected in the Explorer and properties 

windows , and new layers, neurons and connections can be added or changed using 

Step 4. Basic neural network training 

created Multi Layer Perceptron with the data set  imported in the second step, the 

same as in the previous example: 

specified area in the neural network window, and click 

the dialog and click the 'Train' button (Fig. 11) 

 

neural network training for the specified data set  using drag 

3. During the training, Neuroph Studio displays the real-time Total Error graph, as in 

25 

The Multi Layer Perceptron network created by the wizard is automatically opened in the visual editor 

component palette available on the right, for additional inspection and editing (Fig. 

bias neuron with constant output. 

New Neural Network wizard 

Explorer and properties 

windows , and new layers, neurons and connections can be added or changed using the visual editor 

second step, the 

neural network window, and click the 'Train' 

using drag 'n' drop 

time Total Error graph, as in the previous 
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4. After the training, Neuroph Studio displays the Total Network graph for the entire training. If the 

training does not converge, it can be stopped at any time. 

After the training is completed, the user can randomize and modify the existing neural network and 

repeat the training with different training settings, in order to compare the results (e.g. the number of 

training iterations). The user can also create new neural networks with different architectures, or even 

different types of neural networks within the same project. Also it is very easy to execute the basic 

operations on the data set  such as normalization, shuffling, and sub-sampling (by right clicking data set  

in the project window, and selecting appropriate option from right click menu).  

So, the user can easily create different subsets from the original data set , which can be used for 

training and evaluating neural networks (this procedure can also be automated, which is explained in a 

subsequent section). This way, Neuroph Studio provides an easy to use, visual environment for 

experimenting with different neural network settings and types. 

After the network has been trained, the next step is the evaluation of how good the network is trained, 

or how good it solves the problem it is designed for – in this case the Iris flower classification. 

 

Step 5. Evaluating a neural network classifier 

Neuroph provides a number of classifier performance measures, which can be used for evaluating 

neural network classifiers created in Neuroph. It can create a confusion matrix for a given neural 

network and data set , and then calculate the following classifier performance measures: accuracy, 

precision, recall, sensitivity, specificity, false positive rate, false negative rate, error rate, false 

discovery rate, F-measure, Matthews Correlation Coefficient, Q9, and balanced classification rate. It is 

important to note that Neuroph can provide these measures both for binary and multi-class 

classification, in which case it calculates all of these measures for each class (many-to-one approach).  

All of these measures are available on a single click in the Neuroph Studio GUI.  

The Iris flowers classifier neural network created in this example can be evaluated in three steps:  

1. Label output neurons of the neural network with class names (these labels will be used by the 

evaluator as the class names) 

2. Drag 'n' drop the data set  to use for evaluation into the corresponding area in the neural network 

window 

3. Neural network classifier evaluation is launched from the main menu: 'Main Menu > Tools > 

Classifier Test' , which will open the window with classifier performance measures (Fig. 27) 



 

Fig. 27 Performance evaluation 

Figure 27. shows the confusion matrix and classification performance measures for 

Confusion matrix indicates that all samples 

are classified correctly, whereas 27 samples of Setosa are classified correctly, and 23 samples 

incorrectly. All of the supported classification metrics are calculated and shown for all classes.

This result is not satisfactory, which indicat

should be used in order to get better results. For example, if Multi Layer Perceptron with three hidden 

layers is used with 10, 8 and 6 neurons in each hidden layer respectively, and 0.005 learning 

0.3 momentum are used in training settings

incorrectly. 

Since in all these examples the entire 

Neuroph Studio provides an option for sub

original data set  in the data set  right

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

erformance evaluation of the Iris neural-network-based classifier 

Figure 27. shows the confusion matrix and classification performance measures for 

that all samples of the linearly separable classes (Versicolor 

27 samples of Setosa are classified correctly, and 23 samples 

. All of the supported classification metrics are calculated and shown for all classes.

, which indicates that some different architecture and training settings 

should be used in order to get better results. For example, if Multi Layer Perceptron with three hidden 

layers is used with 10, 8 and 6 neurons in each hidden layer respectively, and 0.005 learning 

are used in training settings, only 5 samples of the Setosa class 

entire data set  is used for training, there is a danger of over

Neuroph Studio provides an option for sub-sampling and creating training and test sets from the 

right-click menu. 

27 

 

 

 

based classifier  

Figure 27. shows the confusion matrix and classification performance measures for the two classes. 

linearly separable classes (Versicolor and Virginica) 

27 samples of Setosa are classified correctly, and 23 samples 

. All of the supported classification metrics are calculated and shown for all classes. 

es that some different architecture and training settings 

should be used in order to get better results. For example, if Multi Layer Perceptron with three hidden 

layers is used with 10, 8 and 6 neurons in each hidden layer respectively, and 0.005 learning rate and 

Setosa class are classified 

is used for training, there is a danger of over-fitting, but 

sampling and creating training and test sets from the 
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This way, Neuroph and Neuroph Studio GUI provide the operations commonly used in the neural 

network training, and the users can easily experiment with different settings and approaches. This is 

very helpful and intuitive for users who are new in the neural network and machine learning world.  

Besides this manual procedure, in which the user controls and executes every step, Neuroph Studio also 

provides an automated K-fold cross-validation procedure as part of the training dialog (Fig. 7). This 

procedure automatically generates K different pairs of training and test sets, and trains K different 

neural networks. 

Table IV shows the basic usability metrics for the entire procedure of creating Multi Layer Perceptron 

classifier using GUI. The metrics include: the number of dialogs, total number of required parameters 

in all dialogs, and additional actions (mouse, toolbar). The metrics in Table IV show that almost all 

operations required to train a neural network are executed through a series of wizard dialogs, which 

guide the user through the process and represent a good usability practice. 

Basic usability metrics 

Dialogs 5 

Required Parameters 17 

Actions 2 

 

Tab. IV Basic usability metrics for training Multi Layer Perceptron classifier using GUI 

 

3.2.2. Iris Classification Example in Java Code 

 

This section describes how to implement the entire procedure of training neural network for Iris 

classification problem in Java code, using the Neuroph framework. The procedure includes all the steps 

described for solving the Iris classification using Neuroph Studio GUI: 

1. Neural network training 

2. Data set  sub-sampling 

3. Classifier performance evaluation  

4. Cross-validation procedure 

Code listing 1. shows how to import the Iris data set  from the provided CSV file and train the 

corresponding Multi Layer Perceptron neural network. 

The instance of the data set  which can be used for training a neural networks in Neuroph is created 

from the corresponding file by using the createFromFile() method of the DataSet  class (lines 2 and 3). 

The method createFromFile()takes as its input parameters the file name, the number of inputs, the 

number of outputs, the value delimiter, and a boolean flag that indicates if the input file contains 

column names(although all of these parameters are intuitive, for more detailed explanation see table II).  
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1: 

2: 

3: 

4: 

5: 

6: 

7: 

8: 

9: 

10: 

11: 

12: 

13: 

14: 

15: 

16: 

17: 

18: 

19: 

20: 

21: 

// create data set  from csv file 

DataSet irisDataSet  =  

  DataSet.createFromFile(“iris_data.txt”, 4, 3, "\t", false); 

 

// Create multi layer perceptron neural network 

MultiLayerPerceptron neuralNet = new MultiLayerPerceptron(4, 16, 3);  

 

// get learning rule from neural network 

Backpropagation learningRule = neuralnet.getLearningRule(); 

// set max error parameter 

learningRule.setMaxError(0.01); 

// set learning rate parameter of backpropagation learning rule 

learningRule.setLearningRate(0.02); 

// set max numberof learning iterations 

learningRule.setMaxIterations(10000); 

 

// start network training by calling its learn method 

neuralNet.learn(irisDataSet); 

 

// save trained neural network 

neuralNet.save(“irisClassifier.nnet”); 

 

Listing 1. Import data set  from the CSV file and train the Multi Layer Perceptron  

The instance of the Multi Layer Perceptron neural network is created in Java code using the constructor 

of the MultiLayerPerceptron class (line 6). This constructor takes the numbers of neurons in the layers 

as input parameters, so this code creates a Multi Layer Perceptron with 4 input, 16 hidden, and 3 output 

neurons. It uses the Sigmoid transfer function, and standard Backpropagation as its default learning 

rule. The class MultiLayerPerceptron extends the base NeuralNetwork class. 

An instance of the default learning rule is obtained by using a simple getter method (line 9), and 

learning rule parameters for Backpropagation (max error, learning rate, and max iterations) are set in 

lines 11, 13, and 15, respectively.  

The training procedure is started by invoking the learn() method of the NeuralNetwork class and 

providing the data set as the input parameter (line 18). The training procedure will be finished when the 

total network error drops below the error threshold (the maxError parameter) or the algorithm reaches 

the maximum number of iterations (the maxIterations parameter). 

After the learning procedure has finished, the network is saved in a file by using the save() method of 

the NeuralNetwork class. This method uses the built-in Java serialization mechanism to save an entire 

object to a file, and expects the file name as the input parameter. 

The result of this code is an instance of Multi Layer Perceptron neural network, trained for the Iris 

flower classification and saved on disk. Table V shows the basic code metrics for listing 1. 

These code metrics clearly indicate ease of use of Neuroph for creating an instance and training of 

Multi Layer Perceptron for classification problems. 
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Basic code metrics for training Multi Layer Perceptron 

Lines of Code 8 

Number of classes 3 

Number of method calls 8 

Number of method parameters 11 

 

Tab. V Basic code metrics for training the Iris classifier 

Other types of transfer functions can be used by providing transfer function type to the 

MultiLayerPerceptron constructor. Different types of learning rule can be used by setting different 

learning rule using the setter method of the NeuralNetwork class. For example, to use Resilient 

propagation, that would be neuralNet.setLearningRule(new ResilientPropagation()).To use different 

neural network architecture, which means different number of layers and different numbers of neurons 

in each layer, just provide the desired values for these to the MultiLayerPerceptron constructor. For 

example, to apply this procedure for a different data set , appropriate parameters should be provided to 

DataSet.createFromFile()method, and other parameters (like the neural network architecture and 

learning rule parameters) should be set. 

The procedure described in listing 1. trains the network, but most likely it will do over-fitting since the 

entire data set is used. Sub sampling of the original data set  in order to create the training and test sets 

is a commonly used operation, and the DataSet  class provides methods for this operations. It also 

supports some other typical preprocessing methods, like shuffling and normalization. 

Code listing 2. shows several ways to create training and test sets from the original data set . 

1: 

2: 

3: 

4: 

5: 

6: 

7: 

8: 

9: 

10: 

11: 

12: 

13: 

// create data set  from csv file 

DataSet irisDataSet  = 

      DataSet.createFromFile(“iris_data_normalised.txt”, 4, 3, "\t", false); 

 

// shuffle the original data set   

irisDataSet.shuffle(); 

irisDataSet.normalize(new MaxNormalizer()); 

 

// Create training and test set pair  

DataSet [] trainAndTestSets= irisDataSet 

.createTrainingAndTestSubsets(60,40); 

List<DataSet> subsets = irisDataSet.sample(new SubSampling(60, 40)); 

List<DataSet> subsets = irisDataSet.sample(new SubSampling(60, 20, 20)); 

List<DataSet> subsets = irisDataSet.sample(new SubSampling(4)); 

 

Listing 2. Create training and test sets in Java code 

After the data set  is created from the file (line 2), the order of data set  rows can be randomized using 

the shuffle() method (line 6), and the entire data set  can be normalized using the normalize() method 

(line 7), which takes some implementation of the Normalizer interface to be provided as the input 

parameter. Neuroph provides several typical normalization methods, like max normalization 

(MaxNormalizer), max min normalization (MaxMinNormalizer), range normalization 

(RangeNormalizer) and decimal scale normalization (DecimalScaleNormalizer). 
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The basic way to create the training and test sets is to use the createTrainingAndTestSubsets() method 

of the Data set  class (line 10). This method takes as the input parameter the ratio of training and test 

sets in percents, and returns an array with training and test sets. 

The DataSet  class also provides the sample() method, which takes an implementation of the Sampling 

interface as the input parameter. This example is using instances of the SubSampling class (lines 11, 12, 

13), which provides a method for selecting a subset of the given data set . An instance of the 

SubSampling class is created using the constructor that can take ratios of subsets (lines 11, 12), or 

number of subsets (line 13) to extract. The sample()method returns a list of generated subsets. Custom 

sampling methods can be created by implementing the Sampling interface. 

Code listing 3. shows how to run performance evaluation on a trained neural network classifier and the 

provided Iris data set . 

1: 

2: 

3: 

4: 

5: 

6: 

7: 

8: 

9: 

10: 

11: 

12: 

13: 

14: 

15: 

16: 

17: 

18: 

19: 

20: 

21: 

22: 

23: 

24: 

25: 

26: 

27: 

28: 

29: 

30: 

31: 

32: 

33: 

34: 

35: 

36: 

// load trained network from file 

MultiLayerPerceptron neuralNet = (MultiLayerPerceptron) 

NeuralNetwork.createFromFile("irisClassifier.nnet"); 

// import data set  from file 

DataSet dataSet  = 

       DataSet.createFromFile("iris_data_normalised.txt", 4, 3, ",", false); 

// create an array of class names (needed for classification evaluator) 

String[] classNames = {"Virginica", "Setosa", "Versicolor"};         

// create an instance of evaluation procedure 

Evaluation evaluation = new Evaluation(); 

// add MSE and classification evaluators 

evaluation.addEvaluator(new ErrorEvaluator(new MeanSquaredError())); 

evaluation.addEvaluator(new ClassifierEvaluator.MultiClass(classNames)); 

// run evaluaton for specified neural network and data set  

evaluation.evaluateDataSet (neuralNet, data set ); 

 

// get classification evaluator 

ClassifierEvaluator evaluator = 

evaluation.getEvaluator(ClassifierEvaluator.MultiClass.class); 

// get and print confusion matrix generated by evaluator 

ConfusionMatrix confusionMatrix = evaluator.getResult(); 

System.out.println("Confusion matrrix:\r\n"); 

System.out.println(confusionMatrix.toString() + "\r\n\r\n"); 

 

// calculate classification metrics from confusion matrix 

ClassificationMetrics[] metrics = 

ClassificationMetrics.createFromMatrix(confusionMatrix); 

ClassificationMetrics.Stats average = 

ClassificationMetrics.average(metrics); 

 

// print classification metrics 

System.out.println("Classification metrics\r\n"); 

for (ClassificationMetrics cm : metrics) { 

    System.out.println(cm.toString() + "\r\n"); 

} 

System.out.println(average.toString()); 

 

Listing 3. Evaluating neural network classifier performance, in Java code 

The code from listing 3 loads the trained neural network from the appropriate file (line 2), imports the 

corresponding data set  from its file (line 5), and calculates the mean squared error and classification 

metrics for the given neural network and data set. The main classes used for classifier evaluation are: 
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Evaluation, ClassifierEvaluator, ConfusionMatrix,and ClassificationMetrics.Evaluation represents the 

general evaluation procedure, which consists of running a collection of evaluators (lines 12 and 13) on 

a specified neural network and data set  (line 15). The evaluators can be dynamically added to the 

evaluator, depending of the type of the problem being evaluated. In this case,the MeanSquaredError 

(line 12) and ClassifierPerformance (line 13) evaluators are used. The ClassifierEvaluator class tests a 

neural network classifier for all data in a given data set , and generates confusion matrix that can be 

obtained using Evaluator's getResult() method (line 21).The ConfusionMatrix class holds all 

information about the generated confusion matrix, class names, matrix values, and methods for getting 

the basic metrics (true positive, true negative, false positive and false negative). The 

ClassificationMetrics class provides methods for calculating a number of classification metrics based 

on the basic metrics from ConfucionMatrix (lines 26 and 27). The supported classification metrics are 

listed in section 3.2.1. under step 5,  and the output of the code is shown in figure 27. Table VI shows 

the basic code metrics for code listing 3 (printing lines, network and data set  loading are ignored). 

These metrics indicate the simplicity and ease of use of Neuroph for classifier performance evaluation 

and cross-validation  in Java code. 

 

Basic code metrics for evaluating a neural 

network classifier 

Lines of Code 9 

Number of classes 7 

Number of method calls 11 

Number of method parameters 9 

 

Tab. VI Basic code metrics for evaluating Neuroph-based Iris classifier 

 

Basic code metrics for cross-validation 

Lines of Code 5 

Number of classes 3 

Number of method calls 5 

Number of method parameters 5 

 

Tab. VII Basic code metrics for cross-validation with Neuroph 
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Code listing 4. shows how to run the cross-validation procedure on a trained neural network and 

provided data set . 

1: 

2: 

3: 

4: 

5: 

6: 

7: 

8: 

9: 

10: 

11: 

12: 

13: 

14: 

15: 

16: 

17: 

18: 

19: 

20: 

21: 

// load saved trained network from file 

MultiLayerPerceptron neuralNet = (MultiLayerPerceptron) 

NeuralNetwork.createFromFile("irisNet.nnet");  

 

// create data set  from file 

DataSet data set  = 

 DataSet.createFromFile("data_sets/iris_data_normalised.txt", 4, 3, ","); 

// class names for classifier evaluator 

 String[] classNames = {"Virginica", "Setosa", "Versicolor"};  

 

// create crossvalidation procedure for given neural network and data set  

CrossValidation crossval = new CrossValidation(neuralNet, data set , 5);  

// add classifier performance evaluator 

crossval.addEvaluator(new ClassifierEvaluator.MultiClass(classNames));  

// run  crossvalidation 

crossval.run();  

// get crossvalidation results 

CrossValidationResult results = crossval.getResult();  

 

// print crossvalidation results 

System.out.println(results);  

 

Listing 4. Running cross-validation procedure, in Java code 

The code from listing 4. loads the trained neural network from its file (line 2), imports the 

corresponding data set  from another file (line 6), and runs an appropriate cross-validation procedure 

for a given neural network and the corresponding data set  (lines 12-16). 

The CrossValidation class contains all elements for running the cross-validation procedure: the neural 

network, the corresponding data set  and the evaluators used in the validation procedure. It creates the 

specified number of subsets of the original data set , then trains the neural network with one subset, and 

uses rest of the subsets for evaluation. It repeats this procedure for each generated subset. This way, it 

automates the cross-validation procedure. It can be configured to use various evaluators and data 

sampling techniques. The CrossValidationResult class (line 18) holds the results from all cross-

validation iterations. Table VII shows the basic code metrics for listing 4 (printing lines, network and 

data set  loading are ignored). 

 

 

 

 



 

3.3. Image Recognition 

 

This example shows how to use Neuroph for basic image recognition. It also shows how Neuroph can 

be extended and used for other specific application domains 

that can be supported with specialized tools.

Image recognition in Neuroph is based on using raw pixel color information. RGB color information is 

extracted for each image pixel, and 

network training. This way, each input image corresponds to a single input vector, a

network task is to learn the mappings between the input color vectors and 

labels. It is also possible to map a set of input color vectors to the same label, so this problem is very 

similar to the classification problem.

Neuroph provides a specialized wizard to create 

neural network with image recognition functions.

Through a series of dialogs, the wizard requires from 

some additional settings. The image 

 

Main menu > File > New > Neuroph > Image recognition

 

In the first step, the wizard asks user to select 

 

Fig. 28 The Image 

In second step (Fig. 29),the wizard asks for 

sampling resolution represents dimensions to which 

The smaller dimensions, the less the 

ow to use Neuroph for basic image recognition. It also shows how Neuroph can 

be extended and used for other specific application domains - how its API can be extended, and how 

that can be supported with specialized tools. 

s based on using raw pixel color information. RGB color information is 

extracted for each image pixel, and is used to create an input vector, which is then used for neural 

his way, each input image corresponds to a single input vector, a

network task is to learn the mappings between the input color vectors and a set of predefined image 

labels. It is also possible to map a set of input color vectors to the same label, so this problem is very 

em. 

Neuroph provides a specialized wizard to create data set s from images, and the Multi Layer Perceptron 

neural network with image recognition functions. 

wizard requires from the user to provide the images to recognize an

mage recognition wizard is launched from the main menu:

Main menu > File > New > Neuroph > Image recognition 

wizard asks user to select the images for recognition (Fig. 28). 

 

Image recognition wizard, step 1  -  image selection

 

wizard asks for the data set  name and the sampling resolution

represents dimensions to which the images selected for recognition will be scaled. 

the number of neurons, and the faster the learning. Too small 
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ow to use Neuroph for basic image recognition. It also shows how Neuroph can 

how its API can be extended, and how all 

s based on using raw pixel color information. RGB color information is 

used to create an input vector, which is then used for neural 

his way, each input image corresponds to a single input vector, and the neural 

set of predefined image 

labels. It is also possible to map a set of input color vectors to the same label, so this problem is very 

Multi Layer Perceptron 

user to provide the images to recognize and 

recognition wizard is launched from the main menu: 

image selection 

sampling resolution. The 

images selected for recognition will be scaled. 

learning. Too small 



 

dimensions can have negative impact on 

experimentally. 

 

Fig. 29 The Image recognition wizard step 

In the third step (Fig. 30),the wizard asks for basic Multi Layer Perceptron neural network settings like 

the transfer function and the number of hidden layers (already explained in detail in 

example). 

 

Fig. 30 The Image recognition wizard step 

When the wizard is finished, it automatically creates 

Multi Layer Perceptron neural network with Image Recognition 

API for image recognition. The network is trained 

example: 'drag 'n' drop' the data set 

The trained network can be tested in 

dimensions can have negative impact on the recognition accuracy, so the right values are determined 

 

Image recognition wizard step 2  - data set settings

 

wizard asks for basic Multi Layer Perceptron neural network settings like 

number of hidden layers (already explained in detail in 

Image recognition wizard step 3  - neural network settings

 

When the wizard is finished, it automatically creates the data set  from the provided images and 

Multi Layer Perceptron neural network with Image Recognition plug-in, which provides simple Java 

API for image recognition. The network is trained using the procedure described in 

data set  to the network, and click the 'Train' button in the 

trained network can be tested in the 'Image Recognition Test' window, where the 
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right values are determined 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

settings 

wizard asks for basic Multi Layer Perceptron neural network settings like 

number of hidden layers (already explained in detail in the classification 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

neural network settings 

provided images and the 

which provides simple Java 

the procedure described in the classification 

the toolbar. 

the user can select an 



 

image and see the network output for each image label, which 

recognized. The image label/output neuron with 

(Fig. 31). 

 

 

Fig. 31

Table VIII shows the basic usability metrics for the entire procedure of creating Multi Layer Perceptron 

for image recognition using GUI. The metrics include: number of dialogs, total number of required 

parameters in all dialogs and additional actions (mouse, toolbar

almost all operations required to train neural network are executed through a series of wizard dialogs, 

which guide the user through the process and represent 

Basic usability metrics

Dialogs 

Parameters

Actions 

Table VIII Basic usability metrics for training Multi Layer Perceptron for

see the network output for each image label, which indicates that a specific image is 

The image label/output neuron with the highest activation is the one that 

Fig. 31 Image recognition testing 

 

shows the basic usability metrics for the entire procedure of creating Multi Layer Perceptron 

for image recognition using GUI. The metrics include: number of dialogs, total number of required 

parameters in all dialogs and additional actions (mouse, toolbar). The metrics in T

almost all operations required to train neural network are executed through a series of wizard dialogs, 

user through the process and represent a good usability practice. 

Basic usability metrics 

6 

Parameters 13 

2 

  

Basic usability metrics for training Multi Layer Perceptron for

 image recognition using GUI 
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specific image is 

that is recognized 

shows the basic usability metrics for the entire procedure of creating Multi Layer Perceptron 

for image recognition using GUI. The metrics include: number of dialogs, total number of required 

Table VIII show that 

almost all operations required to train neural network are executed through a series of wizard dialogs, 

Basic usability metrics for training Multi Layer Perceptron for 
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The created image recognition neural network can be saved as a serialized Java component, and used in 

other Java applications.  

The code in listing 5 shows how to use the image recognition neural network created with this wizard 

in other Java applications.  

In line 2, the neural network created in Neuroph Studio is loaded from a file, and in line 5 an instance 

of the image recognition plug-in is acquired by using the getter method getPlugin().The actual 

recognition is run in line 10, using the method recognizeImage() from the ImageRecognitionPlugin 

instance. This method takes an image or an image file that is processed, and returns a hash map with 

the image labels (names) and the likelihoods that a specific image is recognized. 

So, besides the neural network loading and exception handling, the actual image recognition is 

accomplished in just two lines of code. In the entire sample, only two classes from Neuroph are used – 

NeuralNetwork and ImageRecognitionPlugin. 

 

1: 

2: 

3: 

4: 

5: 

6: 

7: 

8: 

9: 

10: 

11: 

12: 

13: 

14: 

15: 

16: 

17: 

// load trained neural network saved with NeurophStudio 

NeuralNetwork nnet= NeuralNetwork.createFromFile("MyImageRecognition.nnet"); 

 

// get the image recognition plugin from neural network 

ImageRecognitionPlugin imageRecognition = 

(ImageRecognitionPlugin)nnet.getPlugin(ImageRecognitionPlugin.class); 

 

try { 

 // actual call to image recognition method  

   HashMap<String, Double> output =  

                imageRecognition.recognizeImage(new File("someImage.jpg"));  

   System.out.println(output.toString()); 

} catch(IOException ioe) { 

   System.out.println("Error: could not read file!"); 

} catch (VectorSizeMismatchException vsme) { 

   System.out.println("Error: Image dimensions dont match !"); 

} 

 

Listing 5. Image recognition in Java code, with the network created in Neuroph Studio 

Table IX shows the basic code metrics for using image recognition neural network in Java code, which 

clearly indicates ease of use of Neuroph for this type of applications. 

Basic code metrics for image recognition 

Lines of Code 2 

Number of Neuroph classes 2 

Number of method calls 2 

Number of method parameters 2 

 

Tab. IX Basic Java code metrics for image recognition with Neuroph 

It is also important to outline the flexibility of the code shown above with respect to using different 

types of neural networks. In order to do that, nothing has to be changed in the code since the same 

ImageRecognitionPlugin is used and it represents an interface for this specific domain. 
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This is also a good example of how Neuroph can, and should be extended for other application-specific 

domains using its plugin-based architecture. More technical details about it are explained in the next 

section. 

 

4. Extending the Neuroph framework 

 

This section provides a brief overview of the classes and methods that represent the main extension 

points. It outlines the required steps and provides guidelines for creating new components in the 

Neuroph framework. Typical scenarios for extensions include: 

1. Creating a new type of neural network architecture 

2. Creating a new type of learning rule 

3. Creating domain-specific operations 

4. Creating a new type of neuron layers 

5. Creating a new type of neurons 

6. Creating a new type of input function 

7. Creating a new type of transfer function 

 

The overall architecture of Neuroph facilitates maximum reusability for extensions by implementing 

the general structure and logic in the base classes, so new specific features can be added in the 

extended classes by overriding abstract methods or providing implementations of some interfaces. 

 

Creating a new type of neural network architecture 

Create a new class that extends class NeuralNetwork. 

Add the method createNetwork() that creates layers of neurons and sets a learning rule. Some specific 

types of neural networks might require new types of learning algorithms. The recommended practice is 

to provide a constructor or an inner builder class to create a network instance, and setter methods that 

allow setting of various network parameters. 

 

Examples: MultiLayerPerceptron, ConvolutionalNetwork, HebbianNetwork 

 

Creating a new type of learning algorithm 

Create a new class thatextends the abstract class LearningRule or some of its subclasses 

(IterativeLearning, Supervised, Unsupervised) and implement the corresponding abstract method: 

LearningRule 

 abstract public void learn(DataSet trainingSet) 

 

IterativeLearning extends LearningRule 

 abstract public void doLearningEpoch(DataSet trainingSet) 

 



39 

 

Supervised extends IterativeLearning 

 abstract protected void updateNetworkWeights(double[] outputError) 

Unsupervised extends IterativeLearning 

 abstract protected void updateNetworkWeights() 

The LearningRule class is the most general base class for learning rules, whereas IterativeLearning is 

the base class for iterative learning procedure and it provides a general iterative learning procedure.  

The SupervisedLearning class is the base class for the family of supervised learning algorithms, and its 

subclasses should implement a method for updating the network weights, based on the output error. 

Examples: LMS, Backpropagation, RBFLearning 

UnsupervisedLearning is the base class for the family of unsupervised learning algorithms, and its 

subclasses should implement a method for updating the network weights.  

Examples: KohonenLearning, HebbianLearning, CompetitiveLearning 

 

Creating domain specific operations (API) 

Domain specific operations (like image recognition) should be created by using the Neuroph plugin 

system. To create a new plug in, create a new class that extends org.neuroph.core.PluginBaseand add 

the required methods, which are usually related to setting the network input and interpreting the 

network output for a specific application. Plug-ins are added to a neural network using the addPlugin() 

method, and requested using the getPlugin() method. 

Examples: ImageRecognitionPlugin, OcrPlugin 

 

Creating a new type of neuron layers 

Create a new class that extends the class org.neuroph.core.Layer and optionally override some of its 

methods, usually: 

public void calculate() 

Since the Layer class is the container for neurons, and its default implementation of the calculate() 

method does not need to be changed for most purposes, the newly extended class usually adds more 

features to the existing basic layer type. 

Examples: Layer2D, ConvolutionalLayer, CompetitiveLayer 

Creating a new type of neuron 

Create a new class that extends the class org.neuroph.core.Neuron and override the method public void 

calculate(). This method calculates the neuron's output. Its default implementation in the Neuron class 

calculates the value of the neuron's input function and feeds that value into the transfer function. The 

output of the transfer function is the neuron's output. 

Different input and output functions can be easily changed using the neuron's setter methods, and the 

only situation when a different type of neuron is needed is when a different method of computation is 

required. 

Examples: CompetitiveNeuron, InputNeuron, BiasNeuron 
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Creating a new type of input function: 
Create a new class that extends the abstract class org.neuroph.core.input.InputFunction and implement 

its abstract method:  

abstract public double getOutput(Connection[] inputConnections); 

This method takes an array of a neuron's input connections, and its implementations should calculate 

and return the result of the corresponding input function. 

Example: org.neuroph.core.input.WeightedSum 

 

Creating a new type of transfer function 

Create a class that extends the abstract class org.neuroph.core.transfer.TransferFunction.Implement its 

abstract method that calculates and returns the value of the transfer function: 

abstract public double getOutput(double net); 

Override its method which returns the first derivative of the transfer function: 

public double getDerivative(double net) 

Example: org.neuroph.core.transfer.Sigmoid 

5. Conclusion 

 

This paper describes Neuroph, an open-source neural network development environment written in 

Java. The application cases presented in the paper show how to use Neuroph to: 

 

1. Demonstrate the basic neural network concepts, visualize learning, network architecture, and 

data set s. 

2. Solve a classification problem using the Multi Layer Perceptron neural network, both with GUI 

and in Java code (where the same procedure is applicable for other types of problems and neural 

networks) 

3. Do basic image recognition, and customize Neuroph for some specific application domains. 

 

These examples also demonstrate the most important Neuroph features, which are: 

 

• It is easy to learn and use, thanks to a small number of well-designed classes and the 

development environment that provides wizard-based and visual tools.  

• Flexible and extensible design, with clear, well-defined and comprehensive extension points, 

which make it easy to develop new types of learning algorithms and neural network 

architectures. 

• High reusability, since it is easy to deploy in different environments (other Java applications), 

and the existing code facilitates development of new components/extensions. 

 

Neuroph is intended to be used by students, teachers, researchers and software developers interested in 

using neural networks.  

Future development will include new types of neural network architectures, learning algorithms, and 

automated tools to support typical workflows (training, validation, testing, deployment) when working 

with neural networks. 
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